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IInnttrroodduuccttiioonn  
 

As I write this, the digital publishing revolution is advancing to a whole new level. 
 
Recently, author Stephen King released a book exclusively on the web.  You can 
download the book absolutely free (although he'd prefer you pay for it) and read it right 
on your computer.   
 
There have also been mergers, acquisitions and movements within the e-publishing 
industry that confirm Ebooks will be with us for quite some time.   
 
With big business entering e-publishing will be their big publishing dollars…which all 
suggests one thing…it's here to stay. 
 
Today anyone, regardless of  
 

• Background 
• Financial position 
• Geographic location 
• Or (even) talent is suddenly on the same playing field as Stephen King.   

 
You have the exact same worldwide distribution opportunities as the most popular 
modern horror fiction writer in the world. 
 
Add to this the fact that the publishing and entertainment industries as a whole have 
been slow to adopt the unlimited possibilities of "on demand", and suddenly we, as 
self-publishers, are way ahead of the game.   
 
We can publish our works on the web, and make them available only to customers 
who want them…no huge printing and delivery costs…and it's all done digitally. 
 
It's a win-win situation for both the publisher and the consumer.   
 
The consumer has everything he could want available to him 24 hours a day (and on 
demand), and the manufacturer doesn't need to risk a costly manufacturing run of a 
product that might not sell.   
 
As a self-publisher, the web makes it possible to publish your works at a cost of nearly 
zero (really just your time and a few dollars worth of software) and sell them on the 
web using automated systems that process and ship your orders literally while you 
sleep.   
 
Now stop and take a deep breath and consider this new reality, made possible only by 
the wonders of the personal computer and the World Wide Web. 
 
Whether you publish how-to information products (like I do) or complete works of non-
fiction (like Stephen King), it's a whole new world out there. One in which the costs of 
product development are strictly one's time and the necessary tools.   
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I created my very first information product in Microsoft Word and in a few short (make 
that long) months I was ready to start selling my manual online. 
 
I had already decided I was going to sell it as a digital download (several months 
before Stephen King!), but a check over my website visitor stats told me that nearly 
35% of my visitors were using an operating system other than Windows. 
 
That means that unless I wanted to exclude 40% of my potential customers, I needed 
a solution that had what the techies call, "Cross Platform Compatibility".  In other 
words, it could be read on any computer in the world. 
 
If you've done your research, you already know that there are currently only two 
options:   
 

• HTML (the web) or 
• PDF (files created with Adobe Acrobat).   

 
Since I wanted to recreate the printed appearance of my book in a digital file, PDF was 
the only option. 
 
But let's face it…Adobe Acrobat was created for techies, by techies.   It has a lot of 
really great features that I have never used once, and probably never will. 
 
It's a difficult program to use because there are a whole lot of things it does that simply 
won't apply to your self-publishing business.  I don't go over those features here.  It 
would only confuse the matter.  If you are the type that must know absolutely 
everything about an application, I heartily recommend the PDF Bible. 
 
For the rest of us, there's this book - a simple step by step guide to taking your idea 
and turning it into a digital product that you can sell from your website… 
 
…And make 100% profit. 
 
So let's get on to the good stuff… 
 
Scot Dantzer 
Philadelphia, PA 

 

 

 

 

 

http://www.amazon.com/exec/obidos/ASIN/0764535773/smarthomebusi-20
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CChhaapptteerr  11  --    WWhhyy  PPDDFF??  
 

In the short history of electronic publishing, there have been a number of 
publishing utilities.  Most are 'compilers'…programs that would take individual 
files and build them into an electronic book.   
 
And these compilers did their jobs well.  You might even be familiar with a few 
of the names (since they're still being used today): InfoCourier, HyperMaker, 
NeoBook, Web Compiler…just to name a few. 
 
The only problem with these compilers is that they were 'platform-specific'.  
That means that you needed a PC using Windows to create your book - and 
your readers needed Windows to read them.  Which is all well and good - 
everybody uses Windows, don't they? 

 
Well what about the folks using Macintosh?  What about our 
friends still using DOS (think nobody uses dos anymore?  Think 
again!).  Sure these folks are a small percentage when 
compared to the millions using Microsoft products, but can you 
afford to turn away even one potential reader for your PDF 
Ebook? 
 
Of course not.   
 
And the people at Adobe realized this when they began 
developing their PDF document format and the accompanying 
reader. 
 
PDF stands for Portable Document Format, a document format 
that can be read on nearly any computer in the world using the 
FREE Acrobat Reader. 
 
Adobe originally developed this powerful application for 
business users (still among the greatest numbers), but its 

cross-format compatibility makes it perfect for electronic publishers worldwide. 
 
A PDF Ebook has as many similarities with HTML (the language that is used to 
publish pages on the web) as it does differences. 
 
For instance: 
 

• PDF files can be viewed directly from Netscape and Internet Explorer….   
 

SSSIIIDDDEEEBBBAAARRR   

More than 
40% of my 
website 
visitors use an 
operating 
system other 
than Windows. 
 
Selling digital 
books on a 
Windows-
based HTML 
compiler 
would have 
cost me 
nearly half of 
my potential 
clients. 
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• Users can read your PDF Ebook online or download the entire book and 
read it from the desktop… 

 
• A PDF Ebook can contain hyperlinks to other parts of the book (such as 

in a table of contents), links to the web and forms (such as newsletter 
subscription forms). 

 
But unlike a Web Page, PDF Ebooks: 
 

• Can be emailed, saved to disc and printed from nearly 
any computer in the world…and they'll look exactly 
how you want them to look. 

 
• Have detailed searching capabilities - readers can find 

exactly what they're looking for anywhere in the book 
with a few simple keystrokes. 

 
• Offer a set of full-featured security options that allow 

you, as the author, to decide whether people can print 
your PDF Ebook, or copy its text and graphics. 

 
• Let you create your custom scripts and enhancements 

to the Acrobat application without any special 
permission from Adobe.  This is great news for product 
developers with the right knowledge…who could 
theoretically create an entire new software product 
using Acrobat as the backbone. 

 

 

1.01 Your PDF Ebook 

 
By far the number 1 reason to publish your Ebook with 
Acrobat is published right on Adobe's Website (at http://www.Adobe.com): 
 

"…Acrobat had an all-time record quarter, making (Acrobat) the Company's fastest-
growing product. This success, coupled with the worldwide distribution of over 100 million 
Acrobat Readers, solidifies Acrobat and Adobe's Portable Document Format (PDF) as 
de facto standards for final form delivery and display of electronic documents."   

 
Wow! Over 100,000,000 Acrobat users.  
 
That means that more people are using daily than there are miles to the sun! 
 

SSSIIIDDDEEEBBBAAARRR   

The Free 
Acrobat 
Reader is 
available for 
the following 
computer 
platforms: 
 
Windows 95, 
Windows 98, 
Windows NT, 
Windows 3.1x, 
OS/2 Warp,  
 
UNIX: DEC 
Alpha, HP-UX, 
IBM AIX,  
Linux, SGI 
IRIX, Sun 
Solaris x86, 
Sun Solaris 
SPARC. 
 
Look for them 
to expend in 
to the Personal 
Data Device 
Market real 
soon! 

http://www.adobe.com/
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This virtually guarantees that when you publish your ebook as an Acrobat PDF 
Ebook, your customers…regardless of where they are, what kind of computer 
they use… 
 
…Can buy and read your Ebook right now!   
 
That's something that can't be said of the html compilers and other self-
publishing products on the market. 
 
Here is a quick rundown of just a few of the benefits to publishing with Acrobat: 
 
 

♦♦♦♦    PDF Ebooks Are Readable On Any Computer in the World 
 
It doesn't matter whether your book was written on a Macintosh or Windows 
system, or what kind of computer your reader is using.  Your PDF Ebook is 
instantly available to your reader. 
 
And since Adobe is committed to the success of Acrobat and its users, you can 
bet that as the electronic publishing industry expands, so will the Acrobat 
product line. 
 
 

♦♦♦♦    PDF Files Have Advanced Viewing and Navigational 
Features 

 
You can include internal and external links, bookmarks, thumbnails of each 
page, articles, forms, buttons for navigation, and viewing options that allow a 
user to magnify or reduce a page to fit within the user's computer screen. 
 
This means your PDF Ebook will look great regardless what kind of computer 
or monitor your reader uses.   
 
 

♦♦♦♦    PDF Files Are Small 
 
Your PDF Ebook can be 1/5 of the size of an HTML file containing the exact 
same graphics and information.  That means that you can create graphically 
rich PDF Ebooks that your customers can download quickly, and effortlessly. 
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1.02 What's Inside Acrobat - The Four Components 

 
This section is really relevant only if you are using the full version of Adobe 
Acrobat to publish your Ebook.  The Free Resources I mention emulate many 
of these utilities, though with varying degrees of success. 
 
While Acrobat is a single application, there are actually 4 separate modules 
inside (and that's not counting the hundreds of 'plug-ins' available across the 
web.)  These include: 
 

♦♦♦♦    Acrobat 
 
This is the program that you use to customize your PDF Ebook.  You can add 
buttons and forms, annotations and multimedia components, just to name a 
few.  This is the main 'finishing' tool for PDF publishers. 
 
 

♦♦♦♦    Acrobat Distiller 
 
Acrobat Distiller is the part of the program that 'prints' your files to the PDF 
format while retaining linking and navigation specifics.  You'll use the Acrobat 
Distiller to generate hyperlinked PDF Ebooks from the application that you use 
to create your manuscript.   
 
I tend to use either Microsoft Word or Adobe PageMaker, depending on how 
much control over the layout I need.  This PDF Ebook was created using 
Microsoft Word 2000. 
 
 

♦♦♦♦    Acrobat PDF Writer 
 
The PDF Writer is the part of Acrobat that can print from any application that 
has a print function.  In most cases though, the PDF Writer will not retain 
internal or external links.  You can add these later in Acrobat if you wish. 
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♦♦♦♦    Adobe Capture 
 
The capture function allows you to scan documents (in your optional paper 
scanner) and instantly convert them into PDF files.  You can also use Web 
Capture to instantly convert web pages (or entire web sites) into PDF files. 
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CChhaapptteerr  22  --    PPDDFF  EEbbooookk  RReeaaddeerr''ss  GGuuiiddee  
 
The navigation features of this book are the same features you will be able to 
give your readers when you create your PDF Ebook.  Many of these features are 
simply not available in a printed book.   

2.01 Links Inside This Book 

 
Adobe Acrobat allows 2 linking methods: 
 

• Links to other resources within the book 
• Links to sites on the internet 

 
These links will always appear as bold, blue, and underlined.   
 
If the link is preceded by http:// this signifies an internet link.  The location of 
this link will open in your browser window.  You will need to be connected to 
the internet to view these link destinations. 
 

 

2.02 Special Text and Graphic Formats 

 
This Style and Color of type indicates a reference to a 
specific command, menu, or window component. 
 
 

SSSIIIDDDEEEBBBAAARRR  This suggests a thought that clarifies a point 
being made in the manual.   
 

TTTIIIPPP  This suggests a shortcut or small piece of advice 
that I've picked up along the way. 
 
 
Other colors, such as dark blue are used for emphasis 
and have no associated links. 
 

 
 

SSSIIIDDDEEEBBBAAARRR   

These navigation 
features are 
inherent in the 
Acrobat PDF 
format.  
 
When you 
publish your 
book with PDF, 
you will be 
giving your 
readers the 
same ease of 
navigation…and 
they'll love you 
for it! 
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2.03 Navigation Features 

 
Acrobat makes navigation easy.  Here's how to move around this book (and 
any other PDF Ebooks you come across): 

 

♦♦♦♦    The Scroll bar  
 
Click on the Scroll Box in the Scroll Bar and drag it down to move backward 
or forward through the book.   
 
You will see the page number visible when you 
click on the box.  Release it when you get to the 
desired page. 

 
 
 

♦♦♦♦    Arrow Keys  
 
Pressing the up or down arrow key will advance you 
through the book one page at a time. 

 
 
 

♦♦♦♦    Table of Contents  
 
In the Table Of Contents click on any subject heading to jump to that section 
of the book. 

 
 

 

♦♦♦♦    Bookmarks  
 
Bookmarks are essentially little pictures of the individual pages of your PDF 
Ebook.  Bookmarks are especially useful if you have a large monitor and can 
see the different appearances of the individual pages. 
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To see the Bookmarks, Click 
 

Window > Show bookmarks. 

 
 
 
 
 
 
 
 
 
 
 

 
 

 
 

2.04 Page Magnification  

 
Generally, the best magnification size to view this book is 100%.   
 
To change this, click on the magnification button on the lower 
left corner of Acrobat's window and hold it in. 
 
 
 
Then simply select the magnification you wish. 
 
 

 

 
 

2.05 Search Features 

 
To find a word, phrase or specific text 
anywhere within a PDF Ebook, click 
CTL-F (Windows) or Command-F 
(Mac) to bring up the Find Window. 
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Type the word you're searching for in the Find What box and click Find. 
 

 

2.06 Print Features 

 
You can print this book as you would any other document.  Please respect my 
(and others') copyrights and intellectual property rights. 
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CChhaapptteerr  33  --    BBeeffoorree  YYoouu  SSttaarrtt  
 
 
Before we begin putting The 5-Minute PDF Creator through it's paces, let's 
take a look at the big picture of PDF publishing. 
 
When you publish your PDF Ebook, you create a file that can be downloaded 
and read from nearly any computer in the world.  It's a very simple process and 
the desktop (or even laptop) computer makes it a relatively painless one. 
 
Here are a few topic areas you should familiarize yourself with: 

3.01 PDF Publishing is NOT… 

 
PDF publishing is not desktop publishing (although it's a kind of desktop 
publishing).  Publishing in PDF means taking your existing documents, be they: 
 

• Computer files 
• Websites 
• Paper documents 

 
And converting them into the universal PDF format.  Think of it as an additional 
printer on your computer.  You (probably) have one printer that handles all of 
your day-to-day print jobs. 
 
With a PDF Publishing tool you have another printer that prints PDF 
documents. 
 
This differs from traditional desktop publishing in that, desktop publishing 
usually refers to the layout process, typography, color separations, and other 
steps that directly relate to the world of print publishing. 
 
PDF publishing, on the other hand, is the simple process of taking your existing 
files and documents and converting them into the PDF format, then adding 
multimedia and interactive elements as you see fit. 
 
The crucial tool for PDF publishing is… 
 
…You guessed it… 
 
The PDF Conversion utility. 
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3.02 Do You Need Acrobat to Publish Your PDF Ebook? 

The short answer to this question is,  "No." 
 
Many of today's top desktop publishing and graphic design applications will 
export your layouts to a full-featured PDF file. Careful though, many of these 
applications are very difficult to use and can be many times more expensive 
than the full version of Adobe Acrobat.  
 
For the more budget minded publisher, there are a number of widely available 
PDF publishing utilities on the web (some free, some not) that will take a 
variety of file formats and convert them into PDF Ebooks.   
 
Here's a quick look at a few of these tools… 
 

 

3.03 Publishing Tools with PDF Output Options 

For years, an easy way to publish PDF documents without purchasing Adobe 
Acrobat has been to use  
 

♦♦♦♦    Adobe PageMaker 
 

 
 
Adobe PageMaker 
 
PageMaker has been a mainstay for print publishers for 
years, and since it comes from Adobe, many PDF publishing 
options (including the Acrobat Distiller) are built into it.  the 
downside is that the application costs nearly $600 USD.   
 

Unless you feel you must have all of the layout tools of PageMaker, you might 
not want to take on such an expense. 
 
 

http://www.adobe.com/products/pagemaker/main.html
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♦♦♦♦    Corel Draw Suite 
 

 
Corel Draw Suite 
 
Corel Draw has been my primary vector graphic 
production tool (before I invested in Macromedia 
Fireworks).  It's bundled with a list of great utilities 
applications (like the Photoshop rival, Corel Photo-

Paint), and it's very intuitive.   
 
But again, the cost is nearly $600 USD! 
 
 

♦♦♦♦    Adobe Illustrator 
 

Adobe Illustrator 
 
Substantially cheaper than PageMaker or Corel Suite, 
Illustrator version 9.0 creates PDF files in it's native format.  
You can save a file directly as a PDF file, as opposed to 
exporting it.   
 

The 'export' feature of a program adds another step to the publishing 
process…and one more opportunity for something to go amiss. 
 
That means it has the most complete balance of desktop publishing, graphic 
design and layout options combined with PDF output options. 
 
And then, of course there's: 
 
 

♦♦♦♦    Adobe Acrobat 
 

Adobe Acrobat 
 
The full version of Adobe Acrobat contains a whole bundle of 
PDF publishing tools and utilities…including the PDF Writer 
and the Acrobat Distiller…the two most useful PDF utilities 
available. 
 

At a price of just over $200 USD, this is a bargain and an absolute must-have 
for the serious PDF publisher. 

http://www.corel.com/
http://www.adobe.com/products/illustrator/main.html
http://www.adobe.com/acrofamily/main.html
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3.04 Free PDF Publishing Tools 

There are two additional PDF publishing tools that I've seen mentioned 
frequently in self-publishing circles. 
 
I must warn you…I have never been able to get either one of these tools to 
work properly.  Let me repeat that: 
 
 

I have never been able to get these publishing tools to work! 
 
 
Now that doesn't mean they won't work for you, but I can't recommend them 
two tools without giving you this warning. 
 
If you are serious…truly serious…about publishing your PDF Ebook, perhaps 
try one of these tools first.  Then if you had the same luck I had… 
 
Buy Acrobat! 
 
 

♦♦♦♦    Create Adobe PDF Online 
 

Adobe's Online PDF Converter 
 
This subscription based conversion utility from Adobe will 
(theoretically) allow you to upload your manuscript and it will 
convert it to a PDF Ebook.  You can have the results emailed 
to you or you can just download it from the site. 

 
It's available for unlimited use for a small monthly fee, but offers a free trial that 
will let you use this online utility 3 times without charge. 
 
Try it out, and if it works for you…congratulations…you've found a (nearly) free 
alternative. 
 
 
 

http://www.adobe.com/acrofamily/main.html
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♦♦♦♦    HTMLDOC from Easy Software Products 
 
 

Easy Software Products 
 
HTMLDOC promises easy creation of PDF 

Ebooks from HTML files.  If you have a word processor with HTML output 
options (such as MS Word), you can take your HTML files and convert them to 
a hyperlinked and secured ebook using this utility. 
 
This tool is available for a free download (although they do charge for tech 
support, so it's a trade-off).  Perhaps it's just my impatience, but I struggled with 
HTMLDOC for a few hours before giving up. 
 
But hey, it's free, so if it works for you….. 
 

 
 

3.05 Before You Publish (Last Minute Tips) 

♦♦♦♦    Creating Your Manuscript 
 
The manuscript is the final document that will be published into 
a PDF Ebook.  It contains all the layout, all the typefaces and 
colors, all the graphics…everything. 
 
In the case of this book, the manuscript is a Microsoft Word 
2000 file.  I use Word because: 
 

• I can easily make links within the file and to the internet 
 

• It's easy to make corrections, and  
 

• The Distiller and PDFWriter tools interface easily with 
Acrobat and other 3rd party utilities. 

 
 

But most of all I like to use Word because it lets me easily 
create chapter headings and subheadings, and an Instant 
Table of Contents, by formatting with… 

 

TTTIIIPPP   

When 
writing the 
manuscript 
for your 
Ebook, don't 
use the page 
numbering 
option. 
 
Page 
numbers in 
your original 
document 
may differ 
than the 
page 
numbers in 
your PDF 
Ebook…don't 
confuse your 
readers! 

http://www.easysw.com/htmldoc/
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♦♦♦♦    Outlines, Headers and Styles 
Headers let you pre-format the appearance, position, and all other characteristics 
on your chapter headings and subheadings. 
 
MS Word and most other quality word processing and layout programs let you 
assign outline levels to individual parts of your manuscript.  For instance: 
 

• Heading Level 1 
o Heading Level 2 

!"Heading Level 3 
 
And so on.   
 
During revisions, changing the style definition for any of these 
headings will change the appearance of each heading 
throughout your entire manuscript. 
 
 

♦♦♦♦    Using Styles 
One benefit of Microsoft Word are the extensive Style 
options.  In short, a style lets you define nearly everything 
about the appearance of your text (that is, the typeface, color, 
indenting, etc.) in advance.   
 
Should you decide to change the any attributes of the style, simply change the 
style definition and Word will reformat all of the text in your document that has 
that style applied to it. 
 
To illustrate, suppose you like the Arial font (the font you're reading right now) 
for the body of your Ebook text.  In most cases, the 'normal' style in Word is 
preset to Times New Roman, black, at a 10-point size. 
 
To change the look of your body text, you can go through your entire Ebook, 
highlight every word, and change the appearance using the standard menus in 
Word.   
 
This is very time consuming, and if you don't like the results you will need to 
select everything and change it again. 
 
A quicker approach would be to simply re-define the 'normal' text style in the 
Format>Styles menu.  When you make changes to the normal style, the new 
attributes will be applied to every word in your Ebook that uses the normal 
style.   
 

SSSIIIDDDEEEBBBAAARRR   

For more 
information in 
using 
Headings, 
Styles, and 
Outlines 
search your 
program's 
'help' file for 
any of those 
terms. 
 
Also be sure to 
search for 
"Table of 
contents" 
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The Styles menu is, in most cases, the drop down 
selection box in the left corner of Microsoft Word. 
 
 
 
 
 
 

 
 
If you decide later that you want to change the 
appearance of a particular style, select Format>Style.   
 
 

 
 
 
 
 

The Style menu will let you 
change any or all of your 
preformatted styles 
(including your body text, 
chapter headings and Table 
of Contents listings) 
 
 
 
 

 
 
 
 
 

 

♦♦♦♦    Using Chapter Headings 
This is where the real magic is.   
 
You can use the styles definitions to define the appearance for chapter 
headings and subheadings.  In the case of this book, I've used three separate 
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heading styles:  The main chapter headings and two subchapter headings.  
These are saved in my styles palette as Heading 1, Heading 2 and Heading 3. 
 

When I create a new chapter to my Ebook, I 
simple apply the top-level heading (Heading 1) 
and my top-level style is applied to the text. 
 
 
Notice how the appearance of the styles 
appears in the menu.  After I apply this style, 
Word knows that this style is a chapter heading 
because it's in the 'Top Level'. 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

♦♦♦♦    Create An Instant Table of Contents 
 
After you've applied the chapter and subchapter styles, 
Word will automatically generate a table of contents for 
your ebook, complete with hyperlinks to the chapter 
pages. 
 
To create a Table of Contents, go to the page where 
you want your table of contents to begin, and select 
Insert>Index and Tables 
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Select the Table of Contents 
tab 
 
Click OK. 
 
Word will create your Table of 
Contents, complete with 
hyperlinks to the chapter 
sections. 
 
 
 
 
 
 
You can update your Table of Contents whenever you make changes to your 
Ebook by highlighting the Table and selecting F9.  you can also apply a 
completely different appearance to the entries in your Table of Contents by 
selecting Modify in this screen.  
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CChhaapptteerr  44  --    SSeettttiinngg  YYoouurr  DDiissttiilllleerr  OOppttiioonnss  
 

The Distiller is the magic tool that takes your manuscript and turns it into your 
PDF Ebook.  if you use a 3rd party conversion utility, it is the job of the Distiller 
that it emulates. 
 
When I first installed my Acrobat software I chose a set of options for the 
distiller and haven't had to touch it since.  That's because it works in the 
background for most PDF creation operations. 
 
You see, many of the more popular word processing and desktop publishing 
programs (such as my favorites, Microsoft Word 2000 and Adobe's Pagemaker 
6.5) are automatically 'connected' to the Distiller program.  Just print using the 
Distiller and it loads your preset Distiller options. 
 
There are a few variables that can affect the way your final PDF Ebook looks to 
the reader.  These variables are set in the Job Options section of the opening 
screen.   
 
There are a host of options available for creating your PDF Ebook.  In this 
example I show you all you need to know.  If you are creating complex PDF 
Ebooks you may want to make additional adjustments in the Job Options 
Screen. 
 

4.01 Start the Acrobat Distiller: 

 

Click on the Distiller Icon 
in the Acrobat folder or 
select Distiller from The 
Start Menu 

 

Choose one of the Job Options 

 

 

 

TTTIIIPPP   

I prefer to keep 
the graphic 
compression to a 
minimum, so 
I've created a 
job option called 
"Screen 
Optimized - No 
Graphic 
Downsampling" 
that fits my 
needs. 
 
Experiment with 
Distiller until you 
find a setting 
that looks best 
for your Ebook.  
Then save it. 
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♦♦♦♦    Choosing the Right Distiller Job Option  
 

 
PressOptimized 
 
This option will generate the most 
accurate color and graphic information, 
but will also create a much larger file size.  
Only use this option if you plan to ship 
your PDF Ebook to a professional printer 
to create a printed version of your PDF 
Ebook. 
 
 
 

 
PrintOptimized 
 
This is a medium graphic-quality setting.  If you will be printing your PDF Ebook 
on a regular computer printer (or expect your reader to print out the book) 
choose this option.  This option is a happy medium between the maximum 
quality settings and the minimum file size settings. 
 
 
ScreenOptimized 
 
Screen Optimized PDF files are the smallest among the three options.  They 
will usually look fine on any computer screen, but may loose too much quality 
on a printout.   
 
Use this if you are sure your reader will be using your book primarily on screen. 
 
 
The option you select in this step will be assigned as the default action for all 
future Acrobat Distiller Jobs.  If you want to change these settings in the future 
you must change them manually. 
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4.02 Creating Your Default Job Options 

 
To access the Compression Job Options, Select: 
 

Settings>Job Options> Compression 

 
The Compression 
tab allows you to 
pre-select how your 
images will be 
compressed using 
Acrobat, and you 
can specify how 
Color, Grayscale or 
Monochrome (black 
& white) graphics are 
handled individually. 
 
The compression 
used by Acrobat is 
"lossy".   
 
 

 
 
That means that the more compression you apply to your images 
and text, the more detail information is lost.  If your customers will 
be reading your PDF Ebook on screen, you should not notice too 
big of a difference.  It's when you get into printing that these 
setting really matter. 

  
 

♦♦♦♦    Applying Compression 
 
You can choose to automatically or manually apply your 
compression.  Automatic compression is selected by default by 
the Distiller. 
 
You shouldn't need to adjust these settings unless you plan to 
have your PDF Ebook professionally printed. 
  
SSSIIIDDDEEEBBBAAARRR   

Choosing 
Downsampling 
reduces the 
image resolution 
to the resolution 
you specify.  
 
72 dpi is the 
standard for 
screen graphics. 

 
In most screen 
cases you won't 
notice a huge 
difference in 
quality at this  
 
You will notice 
downsampling's 
effects more 
readily when you
try to print your 
PDF Ebook. 
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♦♦♦♦    JPEG or Gif - Which One? 
 
JPEG compression retains most of your color information so this is the best 
choice for photos, but it is a 'lossy' compression format.   
 
That means that the more you compress your images, the more detail is lost 
and replaced with 'compression artifacts', or grain and noise. 
 
GIF compression has a major problem with photo images in that it reduces the 
color information to 256 colors.  On the other hand Gif compression is ideal for 
clipart compression and images that contain large areas of solid colors. 
 
The only way to be sure which setting is right for your PDF Ebook is to test a 
few and use the one that looks best (while creating a reasonable file size for 
your distribution method). 
 
Once you've purchased the Acrobat software, there is no extra cost to you to 
create several different versions of the same PDF Ebook (as in this test), so 
don't be afraid to experiment.   
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CChhaapptteerr  55  --    AAccrroobbaatt  HHaass  AAllll  TThhee  TToooollss  YYoouu  
NNeeeedd  

 
Most new publishers are surprised when they first start Acrobat to find that there 
is no File>New command. That's because you generally don't create your book 
in Acrobat (although you can import from a number of sources, as detailed 
below).   
 
No, you create your book in a word processing application (such as Microsoft 
Word) or in a desktop publishing application (such as Adobe Pagemaker).  The 
file you create is your manuscript from which you'll publish your book using a 
PDF publishing utility. 

5.01 The Acrobat Toolbar  

 

♦♦♦♦    The Hand Tool 
 
Use the Hand tool to navigate throughout your PDF Ebook.  
When you press your left mouse button while the Hand tool is 
selected you can 'grab' the page and move it on the screen. 
 
If you use a Microsoft mouse with the 'wheel' in the center, 
you can use the hand tool to scroll through the pages of a 
PDF Ebook. 
 

♦♦♦♦    The Zoom Tool 
 
The Zoom tool allows you to zoom in and out on a particular 
page.  You can also choose from a list of options when you 
right-click on a page with the zoom tool selected. 
 

♦♦♦♦    The Text Select Tool 
 

The Text Select tool allows you to select lines, paragraphs or pages of text.  
You can copy the text to the clipboard and past it into other applications (but 
you must use the TouchUp Text Tool to edit text in Acrobat). 
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♦♦♦♦    The Crop Tool 
 
The Crop tool allows you to crop your PDF Ebook (i.e. change the size of the 
pages) to a size you choose.  When you select the Crop tool, you resize the 
document by drawing an area to crop the page to. 
  

♦♦♦♦    The Notes Tool 
 
The Notes tool allows you to insert 'popup' notes into your PDF Ebook.  You 
can insert: 
 

• Text Notes 
 
 

• Audio Notes (recorded with your on-board microphone) 
 
 

• Stamp Notes (that is, you can apply pre-determined graphics as a 
'stamp') 

 
 

• File Notes (that will allow your readers to launch external applications 
from within your PDF Ebook) 

 

♦♦♦♦    The Pencil Tool 
 
The Pencil tools allow you to 'draw' on you document to draw attention to 
particular words, phrases, etc.  You can also draw: 
 

• Rectangles 
 
 

• Ellipses 
 
 

• Lines 
 
 
 

♦♦♦♦    The Highlight Text Tool 
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The Highlight Text tool will surround text with a yellow 'highlighter' 
appearance.   

 

♦♦♦♦    The Movie Tool 
 
The Movie tools allows you to insert a Windows *.avi or Quicktime *.mov file 
onto the page of your PDF Ebook.  The reader can launch the movie file by 
clicking on the automatically-generated link. 
 
 
 
 
 
 
 
 
 
 
 
 

♦♦♦♦    The Link Tool 
 
The Link tools allows you to create links to places within your PDF Ebook, to 
other PDF documents, to locations on the web, or even to launch external files 
and applications. 
 

♦♦♦♦    The Article Tool 
 
The Article tool allows you to link two different areas of text (articles) that can 
run onto different pages.  This is similar to the way a newspaper will continue 
an article on a page deeper inside the edition. 
 
As a rule, I don't recommend using articles in your PDF ebooks, and do not 
cover them in this text.  Instead, you will create 'articles' using chapter 
headings and sub headings when creating your manuscript. 
 

♦♦♦♦    The Form Tool 
 
The Form Tool allows you to create interactive forms in your PDF Ebook that 
can be posted to a cgi script on the web, or sent to an email address you 
specify. 

Click The Box To View The 
Embedded Movie 
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The form tool makes your PDF Ebooks interactive…you can collect information 
from your readers, ask their opinions, or solicit other kinds of information that 
would just not be possible using a printed book. 
 

♦♦♦♦    The Digital Signature Tool 
 
The Digital Signature tool allows you to 'sign' your PDF Ebook.  This is used 
more for the purpose of sharing documents among a group of users.  As I write 
this, the President of the US is exploring legislation that will legalize digital 
signatures for business documents. 
 
I don't cover digital signatures in this book…your PDF Ebook will be digitally 
signed by you when you publish it under your own name! 
 

♦♦♦♦    The TouchUp Text Tool 
 
The TouchUp Text tool allows you to change the appearance of a character, 
word or line of text. 
 
The TouchUp Text Tool should really only be used to correct errors when you 
convert your Ebook into the PDF format. 
 
If you find you have a lot of errors to correct using this tool, it might be more 
appropriate to fix them in your manuscript, then create a new PDF file. 
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CChhaapptteerr  66  --    EEddiittiinngg  aanndd  CChhaannggiinngg  YYoouurr  PPDDFF  
EEbbooookk  

 
 
Remember, you will create the text of your PDF Ebook in another application 
(such as Microsoft Word) then create a PDF file from it.  This process is very 
quick, and usually occurs without any snags. 
 
Occasionally there will be a few changes, corrections or enhancements you 
might want to make to it for the benefit of your readers.  For instance, when I use 
Adobe's PageMaker to create my PDF Ebooks, I find that occasionally a link or 
text format will be lost in the conversion process. 
 
In these instances, I just load the newly produced PDF file into Acrobat, make the 
changes I want (such as adding links that were lost), and save the file. 
 
This is a great advantage over the number of third-party PDF creation tools.  
When you have the full-sized Acrobat on your computer, you can make these 
simple fixes and additions for the benefit of your readers without having to re-
publish your Ebook. 

6.01 Stamping Your Name on Your Ebook 

 
A savvy reader can learn a lot about how you created your PDF Ebook by 
looking at the Document Info through Acrobat or the Free Acrobat Reader.   

 
In some cases, you might need to change or 
append this information.  To change this 
information, choose  
 

File> Document Info>General 

 
The changes you can make to the file info 
include: 
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♦♦♦♦    Title 
This is the title of the document, but not necessarily the title of the file.  
Changing this information does not change the file name. 
 
 

♦♦♦♦    Subject 
 
This is a description of the subject of your PDF Ebook 
 

♦♦♦♦    Author 
 
This is where you enter your name as the author of the 
book.  This field is automatically filled in with the name you 
used when you installed Acrobat.   
 
If this is different than your name as it appears on the 
cover, you should change it here. 
 

♦♦♦♦    Keywords 
 
This function is more for the benefit of corporate users who ma
documents on a particular server.  You can enter keywords he
blank. 

 

6.02 Changing the Way a File Opens 

 
By default, Acrobat opens a document to the first page at the F
level.  As you make changes to your PDF Ebook you might fin
can mysteriously change themselves. 
 
Or you might decide that you want your PDF Ebook to open to
first (as in a "subscribe to my newsletter" form) or at a specific
magnification.   
 
 
 
 

 

SSSIIIDDDEEEBBBAAARRR   

For the most 
part, no one will 
look for your 
name in the 
Document Info. 
 
But suppose you 
have a friend 
create your 
PDF Ebook for 
you?  Would you 
prefer it was his 
name or yours in
the Document 
info? 
y search many 
re or just leave it 

it Page zoom 
d these settings 

 a specific page 
 page 
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To change the way 
a file opens, 
choose  
 

File>Document 
Info>Open 

 

 

 

♦♦♦♦    Setting the Initial View 
 
The initial view is the way 
your reader sees your PDF 
Ebook when it first opens. 
 
You can choose a particular 
page, choose to show the 
bookmarks and/or 
thumbnails and the 
magnification.   
 
You can also choose to 
display your PDF Ebook as 

single pages, continuous pages or as facing pages. 
 
 

♦♦♦♦    Setting The Window Options 
 
You can also choose to show how the page appears in the window. 
 
 
Resize Window to Initial Page 
 
This option will look at the magnification setting of the initial page (as you 
specified) and reduces the size of the surrounding window to match it. 
 
 
Center Window on Screen 
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This option places the window in the center of the monitor when opened. 
 
 
Open in Full Screen Mode 
 
This option hides the window edges and fills the entire screen with your Ebook.  
While this option looks great on a monitor, your readers might not know how to 
close the window (use the Esc key) 
 

♦♦♦♦    User Interface Options 
 
Hide Menu Bar 
 
This option hides the menu bar.  Your reader can press F7 to get the menu bar 
back. 

 
 

Hide Toolbar 
 
This option hides the toolbar. 
 
 
Hide Window Controls 
 
This option hides the scrollbars, close window and resize window boxes. 
 
After you've made any changes to the document open info, save your PDF file 
and close Acrobat.  The next time you open the PDF Ebook, your changes will 
appear. 
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CChhaapptteerr  77  --    AAddvvaanncceedd  PPDDFF  FFuunnccttiioonnss  
 
 
Acrobat has a list of advanced options that make PDF files easier to read, use 
and navigate. These advanced features include:  bookmarks, thumbnails, 
forms and links. 

7.01 How to Use Bookmarks 

 
Bookmarks are a common component of PDF Ebooks.  The bookmarks 

(essentially the chapter and sub-chapter 
names you give you pages when creating 
them) appear in their own menu in Acrobat. 
 
If you format your document prior to creating 
your PDF Ebook in Microsoft Word or Adobe 
PageMaker or Illustrator (among others) and 
use the proper heading formats, your 
bookmarks will be created automatically from 
your table of contents. 
 
If you haven't used any of these applications 
never fear, you can create bookmarks in 
Acrobat later. 
 
 
 
 

 

♦♦♦♦    Creating a Bookmark: 
 
To create a bookmark, you must first be at the 
destination you want the bookmark to point to. Go to a 
page and zoom (if necessary) to the area you want the 
bookmark to point to. Choose: 
 

Show Bookmarks from the Window menu.  This will 
launch the Bookmark palette. 

 
 
 
 


	Contents
	Introduction
	Why PDF?
	Your PDF Ebook
	PDF Ebooks Are Readable On Any Computer in the World
	PDF Files Have Advanced Viewing and Navigational Features
	PDF Files Are Small

	What's Inside Acrobat - The Four Components
	Acrobat
	Acrobat Distiller
	Acrobat PDF Writer
	Adobe Capture


	PDF Ebook Reader's Guide
	Links Inside This Book
	Special Text and Graphic Formats
	Navigation Features
	The Scroll bar
	Arrow Keys
	Table of Contents
	Bookmarks

	Page Magnification
	Search Features
	Print Features

	Before You Start
	PDF Publishing is NOT…
	Do You Need Acrobat to Publish Your PDF Ebook?
	Publishing Tools with PDF Output Options
	Adobe PageMaker
	Corel Draw Suite
	Adobe Illustrator
	Adobe Acrobat

	Free PDF Publishing Tools
	Create Adobe PDF Online
	HTMLDOC from Easy Software Products

	Before You Publish (Last Minute Tips)
	Creating Your Manuscript
	Outlines, Headers and Styles
	Using Styles
	Using Chapter Headings
	Create An Instant Table of Contents


	Setting Your Distiller Options
	Start the Acrobat Distiller:
	Choosing the Right Distiller Job Option

	Creating Your Default Job Options
	Applying Compression
	JPEG or Gif - Which One?


	Acrobat Has All The Tools You Need
	The Acrobat Toolbar
	The Hand Tool
	The Zoom Tool
	The Text Select Tool
	The Crop Tool
	The Notes Tool
	The Pencil Tool
	The Highlight Text Tool
	The Movie Tool
	The Link Tool
	The Article Tool
	The Form Tool
	The Digital Signature Tool
	The TouchUp Text Tool


	Editing and Changing Your PDF Ebook
	Stamping Your Name on Your Ebook
	Title
	Subject
	Author
	Keywords

	Changing the Way a File Opens
	Setting the Initial View
	Setting The Window Options
	User Interface Options


	Advanced PDF Functions
	How to Use Bookmarks
	Creating a Bookmark:
	Changing a Bookmark's Destination
	Changing A Bookmark's Properties
	Changing the Order of Your Bookmarks

	How to Use Thumbnails
	Creating Thumbnails
	Changing Thumbnails

	Editing Text in Acrobat
	The TouchUp Text Tool
	Changing the Text Appearance
	Moving Text Within a Page
	Deleting Text Within a Page

	Using Notes For Further Information
	Creating a Note:
	Deleting a Note

	Adding Multimedia to Your Ebook
	Inserting Movies Using The Movie Tool
	The Movie Properties Screen
	Automatic Multimedia Events

	Hyper Linking In Acrobat Makes Your PDF Ebook Truly Interactive
	Creating Links
	The Link Properties Box

	The 12 Different Kinds of Links
	'Execute Menu Item' Link
	'Go To View" Link
	'Import Form Data' Link
	'Javascript' Link
	'Movie" Link
	'Open File' Link
	'Read Article' Link
	'Reset Form' Link
	'Show-Hide Field' Link
	'Sound' Link
	'Submit Form' Link
	'World Wide Web' Link

	Working With Links
	Changing Link Properties


	Interactivity With PDF Forms
	Defining the Form Fields
	Creating Text Fields
	Creating a Submit Button
	Assigning Actions to Form Objects


	Prepare Your Ebook For Release
	Locking & Security
	You Decide Who Reads It
	How to Password Protect a PDF Ebook
	How to Prevent Your Readers From Printing Your PDF Ebook
	How To Prevent Your Readers From Changing the Contents of Your PDF Ebook
	How To Prevent Your Readers from Copying the Contents of Your PDF Ebook

	My Preferred Security Settings

	Two Lifesaving Plug-Ins
	The Web Links Plug In
	Creating Web Links
	Removing Web Links

	Paper Capture
	Using Your Scanner to Create PDF Ebooks
	Converting Scanned Pages to PDF Pages
	Finding and Fixing Suspects
	Viewing All Suspects

	Web Capture
	Capturing A Single Web Pages
	Capturing an Entire Website


	The Ebook Publisher's Pre-Launch Checklist
	Step One - Write Your Manuscript
	Three Resources To Help You Write Your Manuscript
	Step Two
	Publish Your Book to PDF

	Step Three
	Check Your Links
	Check Your Enhancements
	Check Your Forms

	Step Four
	Check Your Document Information and Initial View

	Step Five
	Secure Your Ebook

	Step Six
	Packaging Your PDF Ebook

	Step Seven
	Uploading Your PDF Ebook to the Web

	Step Eight
	Taking Orders Online
	Creating a Website That Sells
	Free Secure Order Forms
	Accepting Credit Cards
	Automating the Entire Process


	PDF Publishing Tips And Tricks
	Merging Documents and Inserting Pages
	Exporting (Extracting) Pages
	Replacing Pages
	Deleting Pages


	order: 


